Microsoft Outlook 2000 for Windows

This manual was written for initial training on Microsoft Outlook 2000 for Windows. It will be revised and posted on a web site and/or in the Public Folders section of the Exchange server. In the meantime, you may use this manual as a guide to help you become familiar with the Outlook/Exchange environment.

For assistance with Outlook and Exchange, please use the contacts below.

**Installation and Configuration on Your Computer**

For Faculty & Academic departments ............................................. 255-2077

For Administrative Offices .......................................................... 654-5510

**Questions about Using Outlook**

For Faculty and Academic & Administrative Offices ...................... 255-2077

Use this web site for more information about the Outlook interface using the Desktop Client on the Mac, on Windows, and on the Web.

[http://www.stcloudstate.edu/help/faqs/outlookfeatures.html](http://www.stcloudstate.edu/help/faqs/outlookfeatures.html)
# Table of Contents

## OUTLOOK AT A GLANCE

OUTLOOK BAR ................................................................. 6  
FOLDER LIST ........................................................................ 7  
    Displaying the Folder List .............................................. 7  
OUTLOOK BAR OR FOLDER LIST? ........................................ 7  
CUSTOMIZING THE OUTLOOK BAR ........................................ 8  
    Displaying Small Icons on Outlook Bar ......................... 8  
    Rearrange the Order of Icons on the Outlook Bar .......... 8  
    Adding a New Shortcut Icon to the Outlook Bar .......... 9  
    Adding a New Group to the Outlook Bar ..................... 10  
    Adding Numerous Shortcut Icons to the Outlook Bar ..... 11  
OUTLOOK MENU BAR AND TOOLBARS .................................. 12  
INBOX INDICATORS .......................................................... 13  

## OUTLOOK TODAY

CUSTOMIZING OUTLOOK TODAY ........................................... 14  

## READING MESSAGES

READING A MESSAGE IN A SEPARATE WINDOW .................. 14  
READING A MESSAGE BY USING THE PREVIEW Pane .......... 15  
PREVIEWS MESSAGES USING AUTO PREVIEW ................. 17  

## HANDLING E-MAIL MESSAGES

REPLYING TO MESSAGES .................................................... 19  
FORWARDING MESSAGES ................................................... 19  
FLAGGING A MESSAGE ....................................................... 19  
PRINTING A MESSAGE ........................................................ 20  
MOVING A MESSAGE .......................................................... 21  
DELETING A MESSAGE ........................................................ 21  
    About Deleted Messages ........................................... 21  
HANDLING “JUNK” OR “ADULT CONTENT” E-MAIL .............. 22  
    To turn on Outlook’s built-in filtering for junk/adult mail: 22  
KEY WORDS FOR JUNK AND E-MAIL FILTER ...................... 23  

## SENDING MESSAGES

AUTOMATIC ADDRESSING .................................................... 24  
    Multiple Recipients: .................................................... 24  
USING GLOBAL ADDRESS LIST AND YOUR CONTACTS LIST . 25  
MESSAGE SENDING OPTIONS .............................................. 26  
ATTACHING A FILE TO AN E-MAIL MESSAGE .................... 27  
OPENING A FILE ATTACHMENT ......................................... 28  
HANDLING A FILE ATTACHMENT ....................................... 29
SECURITY FOR FILE ATTACHMENTS ................................................................. 30

INSERTING AN ITEM IN AN E-MAIL MESSAGE ........................................... 31
RECEIVING A MESSAGE WITH AN ITEM ATTACHED .................................. 32
OVERVIEW OF THE OUT OF OFFICE ASSISTANT ...................................... 33
SETTING THE OUT OF OFFICE ASSISTANT .................................................. 33
RULES FOR OUT OF OFFICE ASSISTANT ...................................................... 34
SETTING THE ACTION TO REPLY WITH TEMPLATE .................................... 35
ISSUES REGARDING OUT OF OFFICE ASSISTANT ...................................... 35
   Server Settings ....................................................................................... 35
   Turning it Off ......................................................................................... 35

CUSTOMIZING MAIL SETTINGS .............................................................. 36
SPELLING OPTIONS ................................................................................... 38

USING VOTING BUTTONS ........................................................................ 39
SETTING THE VOTING OPTIONS ............................................................... 40
PERSONAL RESPONSE WITH THE VOTE .................................................... 41
PLACING AND COUNTING THE VOTES ....................................................... 42
CHECKING THE VOTES ........................................................................... 42

SIGNATURES ......................................................................................... 43

CREATING A SIGNATURE ..................................................................... 43
   FORMATTING A SIGNATURE ................................................................. 44
   SETTING A DEFAULT SIGNATURE .......................................................... 45
   TIP ABOUT SIGNATURES .................................................................. 45

CREATING NEW FOLDERS .................................................................... 46

MOVING MAIL ITEMS TO A FOLDER—SEVERAL METHODS ..................... 47

SETTING RULES FOR INCOMING MESSAGES ......................................... 48
   USING FOLDERS TO ORGANIZE THE INBOX ........................................ 48
   USING COLOR TO ORGANIZE THE INBOX ............................................. 49
      Remove the color settings ................................................................. 49
   USING THE RULES WIZARD TO ORGANIZE E-MAIL MESSAGES ......... 50
   STEPS IN THE RULES WIZARD ............................................................ 51

CONTACTS .......................................................................................... 57

CREATING A CONTACT ENTRY ............................................................. 57
   CONTACTS PROPERTIES ..................................................................... 58
   CREATING A NEW CONTACT FROM AN EXISTING E-MAIL MESSAGE .... 59
   CREATING A DISTRIBUTION LIST ........................................................ 59
   COPYING A DISTRIBUTION LIST .......................................................... 61
   VIEWING THE CONTACTS LIST ............................................................ 62
GENERATE A MAP TO AN ADDRESS IN YOUR CONTACTS................................................................. 63

AUTOARCHIVING IN OUTLOOK/EXCHANGE .................................................................................. 64

ABOUT ARCHIVE AND AUTOARCHIVE .................................................................................... 64
TURN ON AUTOARCHIVE ........................................................................................................... 65
SET AUTOARCHIVE PROPERTIES FOR A FOLDER ................................................................. 65
  Where Did My Items Go? ......................................................................................................... 66
  Why Is The Folder I Archived Items From Still There? ....................................................... 66
RETRIEVE ARCHIVED ITEMS.................................................................................................... 67
IMPORT ARCHIVED ITEMS INTO THEIR ORIGINAL FOLDERS ............................................ 67
RETRIEVE ARCHIVED ITEMS BY OPENING THE ARCHIVE FILE ........................................ 68
ARCHIVE ITEMS MANUALLY ..................................................................................................... 70
CHECKING YOUR AUTOARCHIVE SETTINGS.......................................................................... 71
  example of the Calendar’s Default AutoArchive properties ................................................. 71
  Example of the Deleted Items’ default AutoArchive Properties ............................................ 72
WHEN TO SAY “NO!” TO AUTOARCHIVING ............................................................................ 72

CALENDAR.................................................................................................................................. 73

ADDING AN ENTRY TO YOUR CALENDAR: .............................................................................. 75
ALL DAY EVENT.......................................................................................................................... 76
  Calendar Color codes ............................................................................................................ 77
  Modifying Calendar Entries .................................................................................................. 77
RECURRING MEETINGS OR APPOINTMENTS ......................................................................... 78
INVITING OTHERS TO A MEETING: .......................................................................................... 79
  Attendee Availability: ............................................................................................................ 81
REVISING CALENDAR ENTRIES................................................................................................ 82
  Changing a Single Calendar Entry .......................................................................................... 82
  Changing All Entries in a Recurring Series ........................................................................... 82
  Deleting a Calendar Entry ...................................................................................................... 82
  Deleting a Single Calendar Entry in a Recurring Series ...................................................... 82
  Copying a Calendar Entry ........................................................................................................ 83
  Moving a Calendar Entry ........................................................................................................ 83
  Changing a Meeting Entry ...................................................................................................... 83
VIEWING NON-CONSECUTIVE DAYS ON THE CALENDAR.................................................. 84
  Page Setup--Format .............................................................................................................. 86
  Page Setup--Paper .................................................................................................................. 87
  Printing Calendar Details ....................................................................................................... 88
PRINTING MONTHLY CALENDARS ............................................................................................ 89

SHARING A CALENDAR WITH ANOTHER USER ..................................................................... 90

PERMISSION LEVELS ................................................................................................................ 90
STEPS TO GRANT PERMISSION TO ANOTHER USER TO ACCESS YOUR CALENDAR ............ 91
STEPS TO ACCESS ANOTHER USER’S CALENDAR AFTER YOU’VE BEEN GRANTED PERMISSION . 91
REMOVING PERMISSION TO A CALENDAR .............................................................................. 92

DELEGATE PERMISSIONS.......................................................................................................... 93
GRANTING DELEGATE PRIVILEGES .................................................................................................................. 93
Send Meeting Requests and Responses Only to Delegates ............................................................................. 94
REQUESTING MEETINGS ON ANOTHER’S BEHALF ....................................................................................... 95
OPENING THE CALENDAR IN A NEW WINDOW ............................................................................................. 96

TASKS .......................................................................................................................................................... 97

VIEWING TASKS ............................................................................................................................................ 98
Tasks in the Outlook Today View .................................................................................................................. 99
Customizing Task Display in Outlook Today ................................................................................................ 100
Tasks in Calendar Display .......................................................................................................................... 101
TASKS VS. CALENDAR ENTRIES ................................................................................................................ 102
Tasks .............................................................................................................................................................. 102
Calendar Entries .......................................................................................................................................... 102

PUBLIC FOLDERS ....................................................................................................................................... 103
SCSU-ANNOUNCE & -DISCUSS .................................................................................................................... 103

OWA (OUTLOOK WEB ACCESS) .................................................................................................................. 104
MANEUVERING IN THE OWA INTERFACE .................................................................................................... 105
USING THE OUTLOOK TOOLBAR IN OWA ................................................................................................... 106
SENDING A MESSAGE IN OWA ................................................................................................................... 107
Using “Check Names” to Send a Message ...................................................................................................... 109
SETTING OPTIONS WHEN SENDING A MESSAGE ..................................................................................... 110
INSERTING A FILE ATTACHMENT ................................................................................................................ 111

PASSWORD CHANGE .................................................................................................................................. 113

PASSWORD CHANGE VIA OWA (OUTLOOK WEB ACCESS) ........................................................................... 114
Outlook at a Glance

Outlook is a comprehensive messaging and scheduling software that includes several components: E-mail, Calendar, Contacts (address entries and distributions lists), Tasks, Notes and a Journal. The E-mail component includes these folders: Inbox, Deleted Items, Drafts, Outbox and Sent Items.

The Outlook main window looks very much like other windows, with a title bar, menu bar, toolbars and scroll bars. Additional items include the Outlook Bar and Folder List.

OUTLOOK BAR

The Outlook Bar appears as a vertical bar at the left side of the Outlook window. It displays these icons by default. You may add other icons as shortcuts. You may also change from large icons to small icons by right-clicking on the Outlook Bar and selecting the icon style. Small icons may be preferable if you create your own shortcut icons in addition to the default icons displayed here. The Outlook Bar includes two buttons at the bottom: My Shortcuts and Other Shortcuts.

The My Shortcuts bar displays these icons:

- Drafts (1)
- Outbox
- Sent Items
- Journal
- Outlook, Update

The Other Shortcuts bar displays these:

- My Computer
- My Documents
- Favorites
FOLDER LIST

The folder list gives a comprehensive view of icons:

There are + and – buttons to collapse or expand folders. The Outlook Today folder displays the mailbox owner’s name. Under Outlook Today, most of the icons that are spread out between the Outlook Bar and My Shortcuts Bar are listed together.

The numbers beside the Deleted Items folder and Inbox folder indicate the number of messages within those folders that have not been read.
The number beside the Drafts folder indicates the number of drafts that have not been sent.

DISPLAYING THE FOLDER LIST

To display the Folder List, click on the View menu and select Folder List, or click on the triangle button on the Folder Banner and then click on the stick pin button.

The Folder List can be displayed by clicking on the triangle button on the Folder Banner.

OUTLOOK BAR OR FOLDER LIST?

You may opt to display the Folder List rather than the Outlook Bar. It is redundant to display both at the same time. Another option would be to customize the Outlook Bar so it displays all the icons you want to use.
CUSTOMIZING THE OUTLOOK BAR

You may want to add new shortcuts or groups to the Outlook Bar, or change the way the icons appear on the bar. If you decide to add more shortcuts, it is advisable to display small icons rather than the default large icons.

DISPLAYING SMALL ICONS ON OUTLOOK BAR

Right click on a blank spot on the Outlook Bar. From the pop-up menu, select Small Icons.

REARRANGE THE ORDER OF ICONS ON THE OUTLOOK BAR

You may also want to rearrange the order of the icons. Simply drag and drop an icon to a new position. Position your mouse on the icon you wish to move, hold the mouse button down and drag the mouse until you see a vertical black bar in the position you want to place the icon. Release the mouse and the icon will be moved to the new position.

You may use these same methods on the My Shortcuts bar and the Other Shortcuts bar.
**ADDING A NEW SHORTCUT ICON TO THE OUTLOOK BAR**

Right-click on a blank spot on the *Outlook Bar*. From the pop-up menu, select *Outlook Bar Shortcut...*. At the dialog window, click on the item for which you want to create a shortcut icon. Click on the *OK* button and the icon will be placed at the bottom of the *Outlook Bar*. You may move it by dragging it to a different position on the *Outlook Bar*.
**ADDING A NEW GROUP TO THE OUTLOOK BAR.**

By default, there are three groups on the Outlook Bar: *Outlook Shortcuts, My Shortcuts* and *Other Shortcuts*.

You may add additional groups, which will appear as vertical gray bars. Within each group, you can add icons. For example, this is a new group that was added, called *Karen’s Shortcuts*. The new group name appears as a gray bar. Four icons were added to the group: *Deleted Items, Drafts, Outbox* and *Sent Items*.

Right click on a blank spot on the *Outlook Bar* and from the pop-up menu, click on *Add New Group*. A new group will appear at the bottom of the bar—it will bear the name “New Group.” The text is already selected (highlighted in blue), so simply type in a name for the new group and press the *Enter* key.

Click on the new group bar to display its contents (there will be none) and then right-click on a blank spot under the new group name button. From the pop-up menu, click on *Outlook Bar Shortcut* and select what you want to add. Click on the *OK* button and repeat until you’ve added all the shortcuts you want to the new group.

To add numerous shortcut icons more efficiently, see next page.
**ADDING NUMEROUS SHORTCUT ICONS TO THE OUTLOOK BAR**

When you want to add several shortcut icons, a more efficient method is to display both the bar and the *Folder List*. Then simply drag icons from the *Folder List* over to the bar.
OUTLOOK MENU BAR AND TOOLBARS

Parts of the Outlook window, from top to bottom:

**Title Bar**—indicates which component is currently active—in this example, it’s the Inbox.

**Menu Bar**—lists menu items available with the currently active component (context-sensitive). The menu bar will display only options that are available with the **Inbox** when the **Inbox** is displayed.

**Standard Toolbar**—displays buttons that can be used with the component that is currently active. The buttons will change based on which component is displayed (Inbox, Calendar, etc.).

**Advanced Toolbar**—works the same way as the Standard Toolbar (context-sensitive), but displays some advanced feature buttons, including a drop-down list to indicate the way you want to display items in that component.

**Folder Banner**—displays the name of the component that is currently active and has triangle button to click to display the **Folder List**.
INBOX INDICATORS

The inbox has many icons to alert you to specific types of messages (urgent, forwarded, attachment, etc.) These icons will show up under the header categories shown at the top of the Inbox. The categories are: Importance, Message Icon, Flag, Attachment, From, Subject, Received and Size.

You may use these header buttons to do a quick sort by that category.

This example shows six messages in the Inbox. Two have been read, indicated by the “opened envelope” icon under the Message Icon header. Two messages have an attachment, as indicated by the paper clip icon. Three messages have not been read, as indicated by the closed envelope icon. Two messages have an exclamation icon, indicating high importance. One message icon displays the “undeliverable” icon with a message from the system administrator. Unread messages appear in bold typeface. Any message without bold typeface has been read. The message with the “undeliverable” icon has been read, because it does not appear in bold typeface, even though the opened envelope icon is not displayed.

<table>
<thead>
<tr>
<th>From</th>
<th>Subject</th>
<th>Received</th>
</tr>
</thead>
<tbody>
<tr>
<td>Karen Trainer</td>
<td>Special Alert</td>
<td>Fri 05/11/2001 1:29 PM</td>
</tr>
<tr>
<td>System Admin</td>
<td>Undeliverable: Special Alert</td>
<td>Fri 05/11/2001 1:27 PM</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>Respond ASAP</td>
<td>Fri 05/11/2001 1:26 PM</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>First Summer Session</td>
<td>Fri 05/11/2001 1:17 PM</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>configuration instructions</td>
<td>Fri 05/11/2001 12:49 PM</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>Weather forecast</td>
<td>Fri 05/11/2001 12:46 PM</td>
</tr>
</tbody>
</table>

- Green Right Arrow—message has been delivered
- Closed Envelope—Unread message
- Paper Clip—Attachment with message
- Opened Envelope—Message has been read
- Green checkmark—message has been read by recipient
- Blue right arrow—message has been forwarded to another person
- Purple left arrow—reply has been sent
- Red Exclamation—high importance
- Blue down arrow—low importance
- Red flag—message has been flagged for follow up
- White flag—follow up has been completed on flagged message
- Door with blue arrow—recipient of your message is out of the office
- Red left arrow—undeliverable message
- Left curved blue arrow—message has been successfully recalled
- Left curved red line with X—recall attempt has failed
Outlook Today

The Outlook Today view gives you a comprehensive look at the current day—Calendar, Tasks, Messages.

You see items on your calendar—those in gray typeface have already passed.
You see a list of your Tasks.
You see a breakdown of messages—counts of unread messages in your Inbox, Drafts, and unsent messages in your Outbox.

You may like to use this view as a starting point when you open Outlook. You may also want to customize the way information displays in the Outlook Today window. There is a button on this window to Customize Outlook Today (upper right corner of the window).
CUSTOMIZING OUTLOOK TODAY

To change the way items are displayed in your Outlook Today view, click on Customize Outlook Today at the upper right corner of the Outlook Today window.

This dialog window appears. Make your selections and click on Save Changes in the upper right corner of the window.

Note that you can have Outlook Today display when you start Outlook. You can decide which folders to display under Messages, the number of days to display under Calendar and which Tasks you want to display, and in which order.

There are also several Outlook Today styles from which to choose.
Reading Messages

Mail is delivered to your Inbox. It stays there (and resides on the Exchange server—it is not saved on your hard drive) until you delete it or move it to a different folder.

There are several ways to read messages: In a separate window, in the Preview Pane, or in the Auto-Preview.

READING A MESSAGE IN A SEPARATE WINDOW

Double-click on a message line and the message will open in a separate window. From that window, you can deal with the message by:

Repeating to it, Forwarding it, Printing it, Flagging it, Moving it to a folder, Deleting it, or simply moving to the next or previous message in the Inbox. Buttons to perform these actions are on the toolbar in the message window. Notice that these buttons appearing on the toolbar are all relative to what you can do with a message you are reading. This is the context-sensitive toolbar feature.

This message also has attachments that may be read by double-clicking on the attachment icon.

To keep the message window open, and continue to read messages from the Inbox, click on the up or down arrow buttons on the toolbar to read the Next or Previous message.
When you are finished reading all messages, and wish to return to the Inbox view, simply close the separate message window by clicking on the “X” in the upper right corner of the window.
READING A MESSAGE BY USING THE PREVIEW PANE

You can display the Preview Pane to see the message appear below the Inbox. Click on the Preview button on the Advanced toolbar, or under the View menu, click on Preview Pane.

The Preview Pane has scroll bars so you can move up and down to view the entire message. This may be a convenient way to take a quick look at messages. Navigate to the next or previous message by using the Up and Down arrows on the keyboard.

To close the Preview Pane, click on the Preview Pane button again, or remove the checkmark from Preview Pane under the View menu.

<table>
<thead>
<tr>
<th>From</th>
<th>Subject</th>
<th>Received</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Outlook</td>
<td>Welcome to Microsoft Outlook 2001</td>
<td>Fri 5/11/2001 2:22 PM</td>
<td>35 KB</td>
</tr>
<tr>
<td>Karen Trainer</td>
<td>Special Alert</td>
<td>Fri 5/11/2001 1:28 PM</td>
<td>513 B</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Undeliverable: Special Alert</td>
<td>Fri 5/11/2001 1:27 PM</td>
<td>1 KB</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>Respond ASAP</td>
<td>Fri 5/11/2001 1:26 PM</td>
<td>2 KB</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>First Summer Session</td>
<td>Fri 5/11/2001 1:17 PM</td>
<td>2 KB</td>
</tr>
<tr>
<td>Karen L. Wenz</td>
<td>configuration instructions</td>
<td>Fri 5/11/2001 12:48 PM</td>
<td>538 KB</td>
</tr>
</tbody>
</table>

**From**: Help Desk  
**Sent**: Thu 5/10/2001 1:03 PM  
**To**: scsu-announce@STCLOUDSTATE.EDU  
**Cc**:  
**Subject**: Norton AntiVirus campus-wide license.

Get the best virus protection for your computer.

SCSU has purchased a campus-wide license from Symantec in order to provide faculty and staff with the best virus checker and the most up-to-date virus definitions.
PREVIEWING MESSAGES USING AUTO PREVIEW

You may get a very quick view of all messages by using the Auto Preview. You may display messages in this view by clicking on Auto Preview under the View menu.

The Auto Preview displays just the first few lines of a message under its message line in the Inbox (rather than displaying another pane in the Inbox window as the Preview Pane does). This view allows you to quickly scan your messages and respond to the most essential ones first.

Example of the Auto Preview

You may decide which view to use when reading your messages.
Handling E-Mail Messages

After you read a message, you can handle it in a number of ways: Reply to it, Forward it, Flag it, Move it, Print it, or Delete it. There is even a special feature that lets you handle “junk” e-mail.

REPLYING TO MESSAGES

With the message selected, click on the Reply button.

You can type in your reply and then click on the Send button.

After the reply is sent, the icon next to that message in the Inbox will change to the purple left arrow. The next time you open that message in the message window, a banner will appear across the top of the window, informing you of the date on which you sent the reply.

The reply that you sent will appear in the Sent Items folder (displayed when you click on the My Shortcuts button at the bottom of the Outlook Bar).

Some options that you have when replying to a message include replying to the Sender only, or to all recipients of the message. There are other standard options that you may use when replying, forwarding and sending. Those options will be discussed under the Sending Messages instructions.

FORWARDING MESSAGES

You may wish to forward a message to another user. Click on the Forward button.

In this case, you need to use the recipient’s e-mail address. You may simply type in the complete address in the To field, or click on the To button to select an address from the Global Address List. This list will include names and e-mail addresses for all users on the particular Exchange server on which your account resides. Select the name or names you want and click on the button to add them to the To field.

Type your reply in the message field and click on the Send button.

After the forwarded message is sent, the icon next to that message in the Inbox will change to the blue right arrow. The next time you open that message in the message window, a banner will appear across the top of the window, informing you of the date on which you forwarded the message.
FLAGGING A MESSAGE

You may want to “flag” a message to remind you to go back to it later. With the message opened in a separate window, click on the Flag button on the message window toolbar and you will see this dialog window:

Click on the drop-down for the Flag to: field and select one of the flag options (Reply, Review, Follow Up, etc.). For the Due By: You can click on the drop-down to see a calendar and click on a day. The default time is 5:00 pm, but you can manually change the time. If you set a due by date and time, you will get a reminder about the flag.

(To flag a message directly from the Inbox, without opening it in a separate window, select the message by clicking once on it. Then click on the Action menu. Click on Flag for Followup and the dialog window above will appear.)

After you flag a message, a red flag icon appears in the Inbox window. When you are reminded of the flag, you can perform whatever action you’ve flagged it for, and then click on the Flag button on the toolbar and click the button to Clear Flag. This removes the flag icon from the Inbox. You could also mark the item Completed and the flag icon will change from a red flag to a white flag.
PRINTING A MESSAGE

With the message selected, or opened in a separate message window, click on the Printer icon on the toolbar, which will print to the default printer. For more options, click on the File menu, and click on Print. Then from the Print dialog window, select a printer and the desired printing options and click on the OK button.

MOVING A MESSAGE

You may want to move a message out of the Inbox and place it in a different folder. Simply click on the message in the Inbox and click on the Move to Folder icon. A dialog window of your folders will appear. Click on the + button beside a folder if necessary to expand a folder so its subfolders are displayed. Then double-click on the folder to which you want the message moved. The message is removed from the Inbox and placed in the folder you selected.

If you want to move a message, but don’t have a folder created, click on the folder within which you want to create the new folder (typically you will click on the Inbox icon and create your own folders under the Inbox). Then click on the New button at the Move Items dialog window. Type in a name for the folder and click on the OK button. You will be asked if you want to create a shortcut for the folder on the Outlook Bar. Typically, this is not a good idea. The default response to this is “No.” Then click on the OK button to place the message in that folder.

DELETING A MESSAGE

To delete a message, select the message and click on the Delete button on the toolbar. To delete multiple messages from the Inbox, select all messages you want to delete (hold down the CTRL key and click on messages to select non-adjacent messages or hold down the SHIFT key and click on messages to select adjacent messages). Then click on the Delete button on the toolbar.

Another method for deleting messages is to select them and then drag them to the Deleted Items icon on the Outlook Bar.

ABOUT DELETED MESSAGES

Deleted messages are kept in the Deleted Items folder until you open the Deleted Items folder and manually delete them. The deleted messages are not emptied when you close Outlook. If you do not open the Deleted Items folder, the messages are kept there for two months and then they are permanently deleted during the bi-weekly Auto Archive*.

*Auto Archiving is described in detail later in this manual.
HANDLING “JUNK” OR “ADULT CONTENT” E-MAIL

You can have unwanted e-mail messages automatically moved to a specific folder or have them deleted. You can also create a list of the senders of unwanted e-mail messages and have all messages from those senders automatically deleted or moved to the folder of your choice.

Outlook can search for commonly used phrases in such messages and automatically move them from your Inbox to a junk e-mail folder, your Deleted Items folder, or any other folder you specify.

TO TURN ON OUTLOOK’S BUILT-IN FILTERING FOR JUNK/ADULT MAIL:
1. Click on the Inbox icon to select it
2. Click on the Organize button on the toolbar.
3. Click on the Junk E-mail link in the Organize window
4. Select the options you want by clicking the down arrow next to each box in the first bulleted item.
5. Click Turn on.

Note: See the bottom for a list of what Outlook automatically filters. These rules are saved on your local hard drive.

To add people to your own junk/adult blocking lists:
1. Click on the Inbox icon on the Outlook Bar.
2. Select a message from the sender whose messages you want to automatically move or delete.
3. On the Actions menu, point to Junk E-mail, and then click Add to Junk Senders list.

Note: The people you add to YOUR Junk and Adult senders lists are saved locally in Application Data/Microsoft/Outlook/Junk Senders.txt or Adult Content Senders.txt.

You can even download updated filters for common junk mail phrases. For more information, see the Outlook Web site at http://www.microsoft.com/outlook.
KEY WORDS FOR JUNK AND E-MAIL FILTER

The file C:\Program Files\Microsoft Office\Office\filters.txt includes the following default rules:

MICROSOFT JUNK E-MAIL FILTER README

The **Junk** and **Adult Content** filters work by looking for key words. This list is a description of exactly which words the filter looks for and where the filter looks for them.

### Junk E-mail Filter:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From is blank</td>
<td>Body contains &quot;mlm&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;advertisement&quot;</td>
<td>Body contains &quot;@mlm&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;$&quot; AND Subject contains &quot;!&quot;</td>
<td>Body contains &quot;////////&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;free&quot;</td>
<td>Body contains &quot;$$$&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;$&quot;</td>
<td>Body contains &quot;order today&quot;</td>
</tr>
<tr>
<td>Body contains &quot;,000&quot; AND Body contains &quot;$&quot; AND Body contains &quot;!&quot;</td>
<td>Body contains &quot;money back&quot;</td>
</tr>
<tr>
<td>Body contains &quot;for free?&quot;</td>
<td>Body contains &quot;extra income&quot;</td>
</tr>
<tr>
<td>Body contains &quot;for free!&quot;</td>
<td>To contains &quot;friend@&quot;</td>
</tr>
<tr>
<td>Body contains &quot; Guarantee&quot; AND (Body contains &quot;satisfaction&quot; OR Body contains &quot;absolute&quot;)</td>
<td>To contains &quot;public@&quot;</td>
</tr>
<tr>
<td>Body contains &quot; more info &quot; AND Body contains &quot;visit &quot; AND Body contains &quot;$&quot;</td>
<td>To contains &quot;success@&quot;</td>
</tr>
<tr>
<td>Body contains &quot; SPECIAL PROMOTION&quot;</td>
<td>From contains &quot;sales@&quot;</td>
</tr>
<tr>
<td>Body contains &quot;one-time mail&quot;</td>
<td>From contains &quot;success.&quot;</td>
</tr>
<tr>
<td>Body contains &quot;order now!&quot;</td>
<td>From contains &quot;success@&quot;</td>
</tr>
<tr>
<td>Body contains &quot; money-back guarantee&quot;</td>
<td>From contains &quot;mail@&quot;</td>
</tr>
<tr>
<td>Body contains &quot;100% satisfied&quot;</td>
<td>From contains &quot;@public&quot;</td>
</tr>
<tr>
<td>Body contains &quot;check or money order&quot;</td>
<td>From contains &quot;@savvy&quot;</td>
</tr>
<tr>
<td>Body contains &quot;cards accepted&quot;</td>
<td>From contains &quot;profits@&quot;</td>
</tr>
<tr>
<td>Body contains &quot;removal instructions&quot;</td>
<td>From contains &quot;hello@&quot;</td>
</tr>
</tbody>
</table>

### Adult Content Filter:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject contains &quot;xxx&quot;</td>
<td>Body contains &quot;adult web&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;over 18&quot;</td>
<td>Body contains &quot;must be 21&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;over 21&quot;</td>
<td>Body contains &quot;adult en&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;adult s&quot;</td>
<td>Body contains &quot;18+&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;adults only&quot;</td>
<td>Subject contains &quot;erotic&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;be 18&quot;</td>
<td>Subject contains &quot;adult en&quot;</td>
</tr>
<tr>
<td>Subject contains &quot;18+&quot;</td>
<td>Subject contains &quot;sex&quot;</td>
</tr>
<tr>
<td>Body contains &quot;over 18&quot;</td>
<td>Body contains &quot;xxx&quot;</td>
</tr>
<tr>
<td>Body contains &quot;over 21&quot;</td>
<td>Body contains &quot;xxx!&quot;</td>
</tr>
<tr>
<td>Body contains &quot;must be 18&quot;</td>
<td>Subject contains &quot;free&quot; AND Subject contains &quot;adult&quot;</td>
</tr>
<tr>
<td>Body contains &quot;adults only&quot;</td>
<td>Subject contains &quot;free&quot; AND Subject contains &quot;sex&quot;</td>
</tr>
</tbody>
</table>
Sending Messages

To initiate a new message, click on the drop-down button by the `New` button on the toolbar. Select `New message`. The `New Message` window appears. Click on the `To` button and you will see the addresses of all other users on your server.

![Screenshot of Outlook message window](image)

This is the `Global Address List`.

Select a name or names and click on the `To` button, then click on the `OK` button. The names (not the e-mail addresses) will appear in the `To` field of your message:

```plaintext
To: Dan Michaels, Karen L. Wenz
```
AUTOMATIC ADDRESSING

When sending a message, you can use automatic addressing. This allows you to type part of a person’s name in the To field and have the name fill in automatically. It will look for names in the Global Address List.

Example: In the To field, type in a person’s name and press the TAB key. If the name is found, it will be underlined, and the complete name filled in:

![To... Craig C. Overboe](image)

If more than one instance of the name is found, it will be underlined in red:

![To... Karen](image)

Right-click on the name and you will see a pop-up of all the instances of that name.

![To... CC...](image)

Click on the name you wish to use and the full name of that person will automatically fill in:

![To... Karen L. Wenz](image)

**MULTIPLE RECIPIENTS:**

You may send to multiple recipients. Just separate the names with a semicolon (;).

The names will be filled in. If more than instance of a name is found, the name will be underlined and you can right-click on the name to select the one you want. Only one instance of “Craig” was found, so that full name filled in. Multiple instances of “Randy” and “Dan” were found, but here, Outlook is listing the “Randy” and the “Dan” that were used most recently (and underlining them will a dashed green line). To select a different “Randy” or a different “Dan,” right-click on the name to select from the full list of those names. If these are the people you want to send to, simply complete the message and send it.

![To... Craig C. Overboe; Randy D. Kolt; Dan Michaels](image)
USING GLOBAL ADDRESS LIST AND YOUR CONTACTS LIST

When using the automatic addressing, by default, Outlook will look for addresses in the *Global Address List* first. You may want to search your own *Contacts* list first**. You will need to change the default setting.

From the *Tools* menu, click on *Services* and then click on the *Addressing* tab.

![Services dialog box](image)

You will want to specify that your personal addresses should be kept in *Contacts*. (To apply this setting, you’ll need to right-click on the *Contacts* icon on the *Outlook Bar* and click on *Properties*. Then click on the *Outlook Address Book* tab and check the box to “Show this folder as an e-mail Address Book.”)

Also indicate which address list should be searched first. Click on the *OK* button after you’ve made all your changes.

**NOTE:** If you have Outlook set to check names in the *Global Address List* (GAL) first, if Outlook finds a match in the GAL, it will not look any further. If you have a “George” entry in both the GAL and in your *Contacts*, it will display the one it finds in the GAL and will not look any further to display any matches from the *Contacts*. You will have to manually tell it to look more and then tell it to look in your *Contacts* list.
MESSAGE SENDING OPTIONS

You have many options to use when sending e-mail. Click on the Options button on the toolbar to see the dialog window:

You can set the importance level of the message, request a delivery and/or read receipt, use voting buttons (covered in detail later) or even set the message to be delivered at a later time. Make your selections from this screen and click on the Close button.

You can also select from buttons on the toolbar to:
Include an attachment (paper clip), flag the message (red flag), set the importance (red exclamation) to “high.”

After making all your selections, click on the Send button. The message will be sent, and a copy of it will be stored in your Sent Items folder, which is accessible from the Folder List or from the My Shortcuts button on the Outlook Bar.
ATTACHING A FILE TO AN E-MAIL MESSAGE

To send a file via e-mail, position the cursor in the message field and click on the paper clip button on the toolbar, or click on the Insert menu and select File. At the Insert File dialog window, select the file and click on the Insert button in the lower right corner of the window. You will see an icon and the filename appear in the message field. Click on the Send button to send the message.

OPENING A FILE ATTACHMENT

Open the message in a separate message window and double-click on the file icon. The file will open in the appropriate software application. (Of course, you must have that software on your computer—if someone sends you a file of a software type that is not installed on your computer, you may not be able to open the file. Some files can be opened in other applications—for example, Word may attempt to open a WordPerfect file, but it may not display all the files special attributes.)

You can close the file and it will remain attached to the e-mail message. If you made changes to the document, you will be asked if you want to save those changes. If you respond with Yes, the changes will be saved to the file attachment.
HANDLING A FILE ATTACHMENT

You may view the attachment and then close it. The file remains attached to the e-mail message.

You may copy the file to a different location—hard drive, floppy disk, etc.

You may simply clear the file from the message. This allows you to delete the file, but keep the e-mail message.

The options for handling a file attachment can be viewed by right-clicking on the attachment icon:

Note that unless you save the attachment to another location, it remains with the e-mail message. When the message is deleted, the file attachment is deleted with it.
SECURITY FOR FILE ATTACHMENTS

Built-in security in the Outlook/Exchange environment prohibits receiving certain types of files that may contain malicious code. One such file type may contain Visual Basic coding—for instance, Access files (with .mdb extension). If you receive a message with this type of file attached, you will be unable to open it. This is due to a security patch that was added to help prevent the transfer of files that contain viruses.

Work Around:
If you receive an .mdb file attachment, you may use a web browser to open the e-mail message and from the web browser, you can open the .mdb file and save it. Do this only if you know the file is from a trustworthy source.

The Norton Anti-Virus software will check incoming mail for potential viruses. This is an additional safeguard against possible damage caused by viruses.
Inserting an Item in an E-mail Message

Outlook allows you to send items with an e-mail message. These items would be anything you can get to from your Outlook folders. This allows you to send a contact entry such as a person’s address and e-mail information, or a distribution list. You cannot send an entire Contacts folder, only an item from the Contacts folder.

From the message window, click on the Insert menu and select Item. A window pops up to display your folders. Select the folder where the item is located and its contents will be displayed. Scroll to the item you want and click on it. Then click on the OK button.

The item will be displayed in the message window as an icon. Type any comments you want and send the message.
RECEIVING A MESSAGE WITH AN ITEM ATTACHED

When the recipient opens the message, the icon can be dragged to the appropriate icon on the Outlook bar. In this case, the icon would be dragged to the Contacts icon and this would copy the distribution list to the recipient’s Contacts folder.
Out of Office AutoReply

OVERVIEW OF THE OUT OF OFFICE ASSISTANT

When you will be away from your office for an extended period (on vacation, for instance) and you do not expect to be reading your e-mail every day, you may want to use the Out of Office Assistant. This feature will send a reply to any incoming message, stating that you are out of the office for a specified period of time. This message will go out just one time to each sender. For instance, if a person sends you a message on Monday morning, the Out of Office Assistant will automatically send the reply that you set up. If that same person sends you another message the next day, the Out of Office Assistant will not send another auto reply.

SETTING UP THE OUT OF OFFICE ASSISTANT

With your Inbox displayed, from the Tools menu, select Out of Office Assistant

This dialog window will appear. You will type in the AutoReply message that you want sent to anyone who sends you an e-mail message during your absence.
RULES FOR OUT OF OFFICE ASSISTANT
The rules are very much like the rules you set for your ordinary incoming mail. Click on the “Add

Set the conditions and then set the action to be performed. You MUST set an action before Outlook will accept your rule.

When you open your Outlook client, it inform you that your Out of Office Assistant is turned on and will ask if you want to turn it off.
SETTING THE ACTION TO REPLY WITH TEMPLATE

There may be some people that you will want to provide with more information than you give in your generic auto-reply message. In that case, you can set a rule for messages that you receive from specific people and designate a template that they will receive as a reply. In the “Actions” area of the previous dialog window, click on “Reply with Template” and you will see this dialog window. Type in the person’s email address and the message you want them to receive while you are out of the office. Then click on the “Save” button.

ISSUES REGARDING OUT OF OFFICE ASSISTANT

SERVER SETTINGS
The Out of Office Assistant properties are set at the server level, by the System Administrator. By default, the Out of Office Assistant only sends the auto-replies to those people on the Exchange server. You will need to check with your system administrator to find out how the properties are set on your Exchange server.

TURNING IT OFF
When you return from vacation and open Outlook, you will see a prompt to remind you to turn off your Out of Office Assistant.
Customizing Mail Settings

You can customize the way mail is handled on your computer. To change the default settings, from the Tools menu, select Options. Then click on the E-mail Options button. You will see this dialog window:

Note that you can set a default so that replies** include the original message and indent that part of the message. Your reply appears in blue typeface. This helps to distinguish between the original message and your response.

Change the settings to what is most appropriate for your use and click on the OK button.

To see more options, you can click on the Advanced E-mail Options button at this window to see the next dialog window.

**As a courtesy, and for efficiency, it is wise to include the original so your e-mail communicates clearly. Omitting the original and then sending a response may cause a problem if your response doesn’t clearly address the original message.
ADVANCED E-MAIL OPTIONS

Again, make any desired changes and click on the OK button.

Note that you can change the setting to allow the comma to be used to separate addresses rather than the default semicolon.

By default, Automatic Name Checking is Turned On
By default, after you respond to a meeting request, the request is deleted from your Inbox.
SPELLING OPTIONS

You may want to set the spell checking options. From the Tools menu, select Options and then click on the Spelling tab. These are the default settings, but you may customize these to suit your needs. Note that you can set Outlook to “Always check spelling before sending.”

Click on the OK button to save the changes you make.
Using Voting Buttons

Outlook has a unique feature that allows you to send a message to multiple recipients, asking them to vote on a question. You supply the possible voting options. They may be as simple as Yes, No, Maybe, or as complex as you wish. When recipients respond, Outlook tallies the responses and gives you a detailed list of responses as well as an overall count of votes.

To use the Voting option, open a new message and type in the recipients in the To field. Click on the Options button and click in the Use Voting buttons checkbox. Click on the drop-down button to select a default set of voting buttons, or type in your own voting options, separated by semicolons. Close the window. Type in the message and send it.
SETTING THE VOTING OPTIONS

The default voting options are:
Approve; Reject or
Yes; No or
Yes; No; Maybe.

You may set your own voting options by checking the box to “Use voting buttons” and then typing in your own voting options, separating each possible voting option with a semicolon. This example shows four possible votes. When the message is sent, the four possible votes will each have a button.

The recipient sees this in the message window:

The recipient simply clicks on a button to place the vote. The vote is sent as an e-mail message, with the vote appearing in the subject line.
PERSONAL RESPONSE WITH THE VOTE

The recipient also has the option to type in a personal response. Without the response, the vote is simply noted in the subject line. With the response, a message appears in the message window. When voting, this dialog window will appear. The recipient may decide to send the response with the vote, or to edit the response by typing in a personal reply to the voting question. In either event, the vote will be tallied. The person MUST click on a voting button for the vote to be tallied by the sender.

This is a personal reply to the voting question.
PLACING AND COUNTING THE VOTES

When the recipients open the message from you, they will see buttons at the top of the message window. They must open the message in a separate window—the buttons will not display in the Preview Pane. Recipients may respond by simply clicking on a voting button to place their votes.

The first vote they make is the only one that is recorded. If they make more votes, they are not counted, although the e-mail message will still be sent. They can include a message in the text area, but they can also simply vote and send the response without typing in a message.

CHECKING THE VOTES

The sender opens the Sent Items folder (under My Shortcuts on Outlook Bar or in Folder List) and open that message. Click on the Tracking button to see the voting results. You will see the reply totals, plus the individual votes of each recipient.

IMPORTANT NOTE ABOUT VOTING: The voting option is available only to other people who are using Outlook for Windows AND the same Exchange server that you are using. Anyone who is using a different e-mail interface (Pegasus, Eudora, etc.) will not see the voting buttons and will not be able to vote via this method. Other Outlook users who are not on the same Exchange server as you will also be unable to vote.
Signatures

A signature is a standard bit of information that appears at the bottom of e-mail messages that you send. You create a signature, including all the information you want about yourself—full name, position, office location, phone number, e-mail address, etc.
You may create more than one signature to use when sending e-mail. For on campus use, your signature may be shorter than the signature you use when sending e-mail to recipients who are off campus.

Creating a Signature

With your inbox displayed, click on the Tools menu and select Options. Click on the Mail Format tab and at the bottom of the next dialog window, and click on the button for Signature Picker. You may edit existing signatures, remove existing signatures or create new signatures. Select one of the buttons for the appropriate action.

When creating a new signature, you may begin with a blank signature and build it from there, or use an existing signature (which probably already has much of the information you’ll want to include in the new signature) or use an existing file (files of the .rtf format only) to include in the new signature. At this screen, you will name the new signature. Then select Start with a blank signature and click on the Next button.

![Create New Signature](image.png)
FORMATTING A SIGNATURE

You may type the new signature and click on the Font button to apply formatting. This example shows a signature that is formatted in the “Batang” font and italicized. Note that the Paragraph button will allow you to align the paragraph (left, center, right).

Click on the Finish button to finish the signature and return to the previous window. Then click on the OK button.
SETTING A DEFAULT SIGNATURE

Back at the Mail Format window, click on the drop-down button to select the signature you want to use as the default. Notice that None is an option. After selecting a default signature, click on the OK button.

NOTE: You will always have the option to select a signature on the fly when sending a message. However, setting a default signature will save you time and help ensure that you don’t forget to include a signature. In Outlook, the signature appears in the e-mail message immediately, so you are aware that the signature will be included.

TIP ABOUT SIGNATURES

Signatures are stored on your computer’s hard drive---they are NOT stored on the mail server, where your mail, calendar entries, folders, etc. reside.
Creating New Folders

To create a new folder, click on the File menu. Click on New and then click on Folder. At this dialog window, type in a name for the folder and indicate where you want the folder. Click on the OK button and the folder will appear in that position in the Folder List. You may be prompted and asked whether you want to have a shortcut to this folder placed on the Outlook Bar (see prompt below). You may want to consider that you do not need to have a shortcut for every single folder on the Outlook Bar, because it will become cluttered. You may instead choose to use the Folder List. Note that there is a field for indicating what type of item the folder will contain. Of course, if it is for your e-mail messages, you want to select Mail Items.
Moving Mail Items To A Folder—Several Methods

1. To move existing items into a folder, right click on the item in the Inbox and from the pop-up menu, click on *Move to Folder*.

   A dialog window will appear. Click on the + sign next to the Inbox folder if you do not see the folders you created under the Inbox. This will expand the Inbox folder to display the subfolders. Single-click on the appropriate folder and click on the *OK* button, or simply double-click on the appropriate folder. The message will be moved to that folder.

2. Simply drag the message from the Inbox and drop it into the folder on the Outlook Bar, or in the Folder List.

3. Select the message in the Inbox (click on it once) and click on the *Move to Folder* button on the toolbar. The pop-up menu will display the folders and you can select the appropriate folder by double-clicking on it, or by single-clicking on it and then clicking on the *OK* button.
Setting Rules for Incoming Messages

You may set up rules so that incoming messages bypass the *Inbox* and go directly to folders that you have designated. To set up simple rules, use the Organize button on the *Standard Toolbar*. For more complex rules, from the *Tools* menu, click on the *Rules Wizard*.

**USING FOLDERS TO ORGANIZE THE INBOX**

You may want to set up rules to move some e-mail messages into folders that you have created. This helps to streamline the *Inbox* and keep saved mail messages organized so it’s easier to find particular messages.

With the *Inbox* displayed, click on the *Organize* button on the toolbar.

Click on the *Using Folders* link and create a rule to move messages sent to or received from the address you type in. Then select an existing folder or use the *Create* button to create a new folder for the rule.

The rule above will move new messages that were sent to “SCSU-Announce” into the “Campus Announcements” folder.
USING COLOR TO ORGANIZE THE INBOX

Set the color for messages from a particular person and then click on Apply Color and those messages in your inbox will be displayed with that color font.

You may also set a color for messages that were sent only to you. Then click on the Turn On button.

REMOVE THE COLOR SETTINGS

Click on the Organize button. Then click on Using Colors. Click on Automatic Formatting to see a list of the colors you’ve set.

Note that other settings are already applied—Unread messages are in boldface type, etc.

Remove the checkmark from any color you want to turn off. This changes the font color of those messages to the default black. Click on the OK button to save the changes.

When finished organizing, click on the Organize button to close the Organize windowpane.
USING THE RULES WIZARD TO ORGANIZE E-MAIL MESSAGES

This example shows a number of rules that were set up using the Rules Wizard.
STEPS IN THE RULES WIZARD

You can click on the *New* button to create a new rule.

![Rules Wizard](image)

Then follow the steps in the rules wizard.

The first step of the rules wizard:

![Rules Wizard](image)

Make your selections at each step and click on the *Next* button.
When you see a hyperlink, click on it to indicate your selection. Note that the instructions say “(click on an underlined value to edit it).”
When you click on an underlined item, you will be given options. Here you may select from the *Global Address List* OR type in an address:

![Rule Address screenshot](image)

Make a selection or type in a name or address and then click on the *OK* button at this screen.
You will go to the next step:

Make selections and click on *Next* button.
Indicate any exceptions to the rule:

**Rules Wizard**

Add any exceptions (if necessary):
- except if sent directly to me
- except if sent only to me
- except where my name is in the Cc box
- except if my name is in the To or Cc box
- except where my name is not in the To box
- except if from people or distribution list

Rule description (click on an underlined value to edit it):
Apply this rule after the message arrives from Chad [redacted]
moves it to the Amazon folder
You may actually run the rule on mail that is already in your inbox!

Check that option before you click on the Finish button.

There are numerous options for filtering your mail messages. Read each step of the wizard carefully so you use the options that are best suited to your needs.
Contacts

Contacts are addressing items that include people who are not in the *Global Address List*, or in other words, are not on the same Exchange server. In the **Contacts**, you can include **single** addresses for **individuals** or **distribution lists** that include **multiple** e-mail addresses. You can store many details in **Contacts**, including names, postal address, phone, fax, cell phone numbers and multiple e-mail addresses. You can use the **Contacts** for easily addressing e-mail messages to persons with whom you frequently correspond.

Creating a Contact Entry

Click on the **Contacts** icon on the **Outlook bar** and from the **Actions** menu, click on **New Contact**.

Enter information. For more than one e-mail address for the same person, click on the drop-down button next to E-mail. Then click on E-mail 2 or E-mail 3. When finished typing in all the information, click on the **Save and Close** button.
CONTACTS PROPERTIES

By default, your contacts will be listed alphabetically by last name. The full names will be entered as First Name Last Name. You can change this by going to the Tools menu and selecting Options. By the Contacts icon, click on the button for Contact Options. At the dialog window, select your choices for the way names will be displayed in your Contacts list. Then click on the OK button.

Outlook does have something called an Address Book, but since the Contacts can do all that the address book does and much more, it is recommend that you use the Contacts for storing e-mail addresses and distribution lists for all your correspondents.

You may need to specify that your Contacts list should be considered an e-mail address book. You can right-click on the Contacts icon on the Outlook Bar and click on the Outlook Address Book icon to see if this has already been set. Make sure there is a checkmark in the box to “Show this folder as an e-mail Address Book.” Click on the OK button.
CREATING A NEW CONTACT FROM AN EXISTING E-MAIL MESSAGE

To create a new contact from a message you are reading, right-click on the sender’s address in the message window and select *Add to Contacts*. Outlook will find as much information as possible and place it in a new Contacts entry. You can open the entry and add more information, such as phone number, etc.

CREATING A DISTRIBUTION LIST

You may create a distribution list by clicking on the *File* menu and selecting *New* and then *Distribution List*. Type in a name for the list and select the people you want to include in the list. You may click on the *Select Members*… button to select people from the *Global Address List*, *Contacts* or you may click on the *Add New*… button to simply type in the e-mail address and name of the person you want to add.
When selecting members, you will see this dialog window:

You may use the *Global Address List* and/or your own *Contacts* to add people to the distribution list.

Another method is to click on the *Add New…* button to type in addresses that aren’t in the *Global Address List* or your own *Contacts*. You will see this dialog window:

Type in names and addresses of people you want to include on the distribution list. Click on the *OK* button after each entry.

After you’ve added all the people you want, click on the *Save and Close* button in the upper left corner of the *Distribution List* dialog window. The name of the distribution list will appear in your *Contacts*. It will be identified by a special icon to indicate that it is a distribution list.
COPYING A DISTRIBUTION LIST

If you have a distribution list from another e-mail application, you can copy and paste it into a new distribution list in Outlook.

- Open the other e-mail application and open the distribution list.
- Select the e-mail addresses and copy them (use the CTRL + C keyboard command or whatever other method the application allows).
- Open Outlook and from the File menu, select New and then select Distribution List.
- At the dialog window, name the distribution list and click on the Select Names button.
- At this dialog window, click in the Add to Distribution List box and paste the addresses in (use the CTRL + V keyboard command).

Click on the OK button and then click on the Save and Close button in the upper left corner of the Distribution List dialog window.
VIEWING THE CONTACTS LIST

There are several ways to view the entries in your Contacts list. By default, they will be displayed as Address Cards.

You can click on the drop-down button to find other options for viewing the Contacts.

You can use the navigating buttons to jump to a section.
GENERATE A MAP TO AN ADDRESS IN YOUR CONTACTS

A unique feature in the Contacts allows you to generate a map for the person’s address. Open the entry so it is in a separate window. On the toolbar, you’ll see an icon for a road sign. Click on it and your web browser will launch, taking you to a website that displays a map to the address. From there, you can also request driving directions. To use this feature, make sure that--

- the address field contains a street address in the first line (not a P.O. box or a company name).
- the zip code is limited to 5 characters.

A map was generated, pin-pointing the address location. From here, you could get driving directions by clicking on the link below the map.

Other options

Get driving directions to this location
AutoArchiving in Outlook/Exchange

What is Auto Archiving?
Microsoft Outlook Help provides this overview of Archiving and AutoArchiving:

ABOUT ARCHIVE AND AUTOARCHIVE
Your Outlook mailbox grows as items are created in the same way that papers pile up on your desk. In the paper-based world, you can occasionally shuffle through your documents and store those that are important but not frequently used. Documents that are less important, such as newspapers and magazines, you can discard based on their age.

You can quickly complete the same process in Outlook. You can manually transfer old items to a storage file by clicking Archive on the File menu, or you can have old items automatically transferred by using AutoArchive. Items are considered old when they reach the age you specify. With AutoArchive, you can either delete or move old items. Outlook can archive all types of items, but it can only locate files that are stored in an e-mail folder, such as a Microsoft Excel spreadsheet or Word document attached to an e-mail message. A file that is not stored in an e-mail folder cannot be archived.

AutoArchive is a two-step process. First, you turn on AutoArchive. On the Tools menu, click Options, click the Other tab, and then click AutoArchive. Second, you set the AutoArchive properties for each folder that you want archived. At the folder level, you can determine which items are archived, and how often they are archived. You can automatically archive individual folders, groups of folders, or all Outlook folders. The process runs automatically whenever you start Outlook. The AutoArchive properties of each folder are checked by date, and old items are moved to your archive file. Items in the Deleted Items folder are deleted.

Several Outlook folders are set up with AutoArchive turned on. These folders and their default aging periods are Calendar (6 months), Tasks (6 months), Journal (6 months), Sent Items (2 months), and Deleted Items (2 months). Inbox, Notes, Contacts, and Drafts do not have AutoArchive activated automatically.

There is a difference between exporting and archiving. When you archive, the original items are copied to the archive file, and then removed from the current folder. When you export, the original items are copied to the export file, but are not removed from the current folder. In addition, you can only archive one file type, a personal folder file, but you can export many file types.

When you archive, your existing folder structure is maintained in your new archive file. If there is a parent folder above the folder you chose to archive, the parent folder is created in the archive file, but items within the parent folder are not archived. In this way, an identical folder structure exists between the archive file and your mailbox. Folders are left in place after being archived, even if they are empty.
TURN ON AUTOARCHIVE

1. On the Tools menu, click Options, and then click the Other tab.

2. Click AutoArchive.

3. To set AutoArchive to turn on when you start Outlook, select the AutoArchive every check box.

4. To specify how often the AutoArchive process will run, enter a number in the days box.

5. To be notified before the items are archived, select the Prompt before AutoArchive check box.

6. In the Default archive file box, type a file name for the archived items to be transferred to, or click Browse to select from a list.

7. Now that you have turned on AutoArchive, you must set AutoArchive properties for each folder to activate AutoArchive.

SET AUTOARCHIVE PROPERTIES FOR A FOLDER

1. Right-click the folder you want to AutoArchive, and then click Properties on the shortcut menu.

2. Click the AutoArchive tab.

3. To enable automatic archiving of this folder, select the Clean out items older than check box.

4. To specify when items should be automatically transferred to your archive file, enter a number in the months box.

5. To specify a file for the archived items to be transferred to, click Move old items to.

6. In the Move old items to box, type a file name for the archived items, or click Browse to select from a list.

Note To activate AutoArchive, on the Tools menu, click Options, click the Other tab, and then click AutoArchive.
**WHERE DID MY ITEMS GO?**
You may have previously enabled [AutoArchive](#), and the date you specified has passed. On the **Tools** menu, click **Options**, click the **Other** tab, and then click **AutoArchive**. The archive file name appears in the **Default archive file** box. Once you know the name of your archive file, you can retrieve archived items.

Example: C:\WINDOWS\Local Settings\Application Data\Microsoft\Outlook\archive.pst

**WHY IS THE FOLDER I ARCHIVED ITEMS FROM STILL THERE?**
When you archive, the original items are copied to the archive file and then removed from the active folder. Original folders are left in place once items are archived, even if the folders are empty. To remove the empty folder, right-click the folder, and then click **Delete Folder name** on the shortcut menu.
RETRIEVE ARCHIVED ITEMS

You can retrieve items from an archive file either by importing the archive file or by opening the archive file. If you import the archive file, you move all the archived items back into your mailbox, into the folders from which they were archived. You can also choose to import the archived items into a new folder. If you open the archive folder, it is added to your folder list, and you can manually copy items into the appropriate folders.

IMPORT ARCHIVED ITEMS INTO THEIR ORIGINAL FOLDERS

In order for this procedure to work, you must have an archive file available. Learn how to archive or delete old items.

- On the File menu, click Import and Export, and then follow the instructions in the Import and Export Wizard for importing a personal folder file (.pst).

Note On the Import Personal Folders page of the Import and Export Wizard, be sure to click Import items into the same folder in, and then click the appropriate set of folders.
RETRIEVE ARCHIVED ITEMS BY OPENING THE ARCHIVE FILE

Click on the File menu and select Open. Click on Personal Folders File (.pst)
At the dialog window, maneuver to your archive location.

Click on the OK button and the .pst file will be placed in a folder in the Outlook Folder List.

Click on the + beside the Archive Folders icon to expand the folders.

You will see icons for the folders of items that have been archived. Click on an icon to display the items in that folder.

You can move items back to their original folders by dragging them or cutting and pasting them.

You may leave the Archive Folders icon there, but this may be counterproductive for the purpose of saving space on the server.

To remove the Archive Folders from the Folder List, right-click on the icon and from the pop-up menus, select Close “Archive Folders.”
This shows the Archive Folders expanded and the Mailbox for the user expanded. Select the Archive folder from which you want to move archived items. Its contents will be displayed on the right pane of the Outlook window. Select and drag items from the right pane of the window to the appropriate folder under the Mailbox.
ARCHIVE ITEMS MANUALLY

1. On the File menu, click Archive.

2. To archive all folders, click Archive all folders according to their AutoArchive settings. To archive one folder only, click Archive this folder and all subfolders, and then click the folder that contains the items you want to archive.

3. In the Archive file box, type a file name for the archived items to be transferred to, or click Browse to select from a list.

4. In the Archive items older than box, enter a date. Items dated before this date will be archived.
CHECKING YOUR AUTOARCHIVE SETTINGS

To see if AutoArchiving is already turned on, click on the Tools menu and select Options. Click on the Other tab. Click on the AutoArchive button. This dialog window will be displayed:

![AutoArchive Dialog Window]

Note the instructions to check each folder for its AutoArchive properties.

EXAMPLE OF THE CALENDAR’S DEFAULT AUTOARCHIVE PROPERTIES

![Calendar Properties Dialog Window]

Note that old Calendar items are NOT permanently deleted. The items are moved to an archive file on the computer’s hard drive. This is the default for autoarchiving Calendar items. You may adjust these settings.
Example of the Deleted Items’ default AutoArchive Properties

Note that old Deleted Items will be PERMANENTLY deleted, and will not be moved to an archive location. This is the default for autoarchiving deleted items. You may adjust these settings.

You can set the Autoarchive properties for all the folders that Outlook allows, including your personal folders. You may choose to set the properties on some of your personal folders so they are NEVER archived, and then you can handle those manually.

When to Say “NO!” to AutoArchiving

If you log on to a computer other than your own, and you are prompted to autoarchive, you will want to respond with a “No” because if you allow the autoarchiving procedure to take place, items will be placed on an archive site on that computer’s hard drive. By default, you are prompted before the Autoarchive procedure begins.
## Calendar

Outlook provides you with an electronic calendar that interfaces with your e-mail. You place appointments and meetings on the electronic calendar the same way as you would a paper calendar, but the electronic calendar has MANY more features!

An example of a calendar displayed in the weekly format. Notice the way certain items are displayed:

The **bell symbol** indicates that a **reminder** is set for that calendar entry.
The **double circular arrows** indicate **recurring** meetings or appointments.
There is a **banner** across two days to indicate an **all-day event**.
The **office hours** have a **lighter** background than the before and after office hours.
The **hours** are indicated by the hour, with ½ hour tick marks. This can be changed by right-clicking on the calendar and selecting “Other Settings.” **

<table>
<thead>
<tr>
<th>Mon, Apr 15</th>
<th>Tue, Apr 17</th>
<th>Wed, Apr 18</th>
<th>Thu, Apr 19</th>
<th>Fri, Apr 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes:**
- **Bell symbol** indicates a reminder.
- **Double circular arrows** indicate recurring meetings or appointments.
- **Banner** across two days indicates an all-day event.
- **Office hours** have a lighter background.
- **Hours** are indicated by the hour with ½ hour tick marks.
Right-click anywhere on the calendar to see the *Other Settings* dialog window:

![Format Day/Week/Month View](image)

You can change the *time scale* to 15 minutes if you like. Under the *General Settings*, you can set the date navigator to display days that contain items in boldface so you can see at a glance if you have anything on your calendar for that day. By default, this is already turned on. This *Date Navigator* shows that every day in May has something on the calendar, but some days in June don’t have anything on the calendar yet. You can use the *Date Navigator* to quickly display a particular date or week, by clicking on a date to display it on the calendar.

![Calendar](image)

Use the Calendar Toolbar to indicate how much of your calendar you want to display:

![Calendar Toolbar](image)
ADDING AN ENTRY TO YOUR CALENDAR:

Double-click on the time slot where you want to add the item (or click on the drop-down button by New and select Appointment) and this dialog window will appear:

Type in the subject and location of the appointment.
Use the start and end time drop downs to indicate the duration.
The default is to get a reminder 15 minutes prior to the appointment time, and to show the time as “Busy” on your calendar.
You can type in details in the large white text box below the reminder.
Click on the Save and Close button in the upper left of the dialog window and the entry will be placed on your calendar. You will see the subject and location on the calendar.

The lower right corner of the new appointment window has a checkbox that enables you to mark a calendar item as private. Even if you share your calendar with another person who schedules your appointments, that person will not see the details of this entry—only that you are marked “busy” during that time period.
The entry displays on the calendar like this:

The subject is listed and the location is indicated in parentheses.
If you point the mouse to the calendar entry, a sticky note will display the time range for the appointment, as well as the subject and location.
ALL DAY EVENT

Notice that you can schedule something as an all-day event. This may be useful if you want to indicate an event on your calendar, but don’t want to show the entire day as busy. By default, when you set an entry as an all-day event, your time is shown as “Free.” If indeed, it’s an all-day event and you will not be available for any appointments, make sure to mark the time as “Busy.” Notice that you will be notified if there is a conflict with items already entered on your calendar. (This features allows you to double-book yourself, so you know which meetings you are invited to, and allows you to display the start and end times so you can attend parts of the meetings if you wish.)

Double-booking appears like this:

You can see the duration of each meeting or appointment, and you will not forget that there was another meeting you were asked to attend.
**CALENDAR COLOR CODES**

<table>
<thead>
<tr>
<th>Condition</th>
<th>Color Code</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Busy</td>
<td>Medium Blue</td>
<td>Unavailable for Meetings</td>
</tr>
<tr>
<td>Free</td>
<td>White</td>
<td>Available for Meetings</td>
</tr>
<tr>
<td>Tentative</td>
<td>Light Blue</td>
<td>Holding that time for a possible appointment</td>
</tr>
<tr>
<td>Out of Office</td>
<td>Purple</td>
<td>Not in Office, but available for meetings at another location</td>
</tr>
</tbody>
</table>

These are the conditions you can set on your calendar for your availability. Unless you are marked busy, tentative, or out of office, the time will show up as “free.” If you wish to block out specific times to work on projects, write the project in as a calendar entry and mark the time “busy.” This will prevent others from requesting a meeting at that time.

The color code appears as a vertical bar on the right side of the calendar entry.

---

**MODIFYING CALENDAR ENTRIES**

You can change calendar entries after they have been created. Simply right-click on the entry and select from the pop-up menu to *Delete, Mark as Private, Print* or *Open* (to modify). When you open the entry and make changes to it, you must click on the *Close and Save* button in the upper left corner of the window.
**RECURRING MEETINGS OR APPOINTMENTS:**

When entering an appointment or meeting, you may indicate that it recurs. Click on the Recurrence button and you will be asked how frequently the appointment or meeting occurs and how long you want to extend the recurrences.

Fill in the information to indicate the recurrence pattern and the range of recurrences. You can end after a certain number of occurrences or by a certain date. You can click on the drop-down button by the End by date to select a date from the calendar.

Recurrence patterns allow you to select the first Tuesday of the month, the last Friday of the month, the last weekday of the month, etc.
INVITING OTHERS TO A MEETING:

Create the information about the meeting and then click on the *Invite Attendees* button.

You will see a banner that says *Invitation*. Type in a message in the big white text box that invites people to the meeting, describing what the meeting will be about, etc. Then click on the “To” button.
Indicate the people who are required at the meeting or are optional.

When finished at this screen, click on the **OK** button.

The names will appear in the **To** field. Click on the **Attendee Availability** tab.
ATTENDEE AVAILABILITY:

You will see if the people you want to invite are available for that time. There is a legend to show which colors indicate busy, tentative, out of office, or no information available. The grid shows one person who has something tentative at that time, but the other people are all available.

You can use the AutoPick buttons to jump ahead or back to a time that every person is available. After selecting a time that everyone is available, click on the “Send” button to send the invitation. You will not receive an invitation, since you initiated the meeting. The entry will be placed on your calendar.

People will receive the invitations in their Inboxes. The message will have a symbol like this: 📧 to indicate it is an invitation to a meeting. People may decline, accept, or tentatively accept. When you open a reply, it will list which people have accepted, declined or tentatively accepted.

If you make a change to the meeting on your calendar, (such as change the time or delete the meeting), Outlook will prompt you to send a message to all invitees to notify them of the change. This applies to meetings that YOU organized.
REVISING CALENDAR ENTRIES

You may need to copy, move, delete or change calendar entries. Open the calendar so the entries are displayed. Then follow the instructions below for the type of change you need to make.

CHANGING A SINGLE CALENDAR ENTRY

Right-click on the entry you want to change, and from the pop-up menu, select Open. The entry opens in a window and you can make the changes. Click on the Save and Close button in the upper left corner of the window.

CHANGING ALL ENTRIES IN A RECURRING SERIES

Right-click on the entry you want to change, and from the pop-up menu, select Edit Series. The entry opens in a window and you can make the changes. Click on the Save and Close button in the upper left corner of the window. This will change all the entries for that recurring series.

DELETING A CALENDAR ENTRY

Right-click on the entry you want to delete, and from the pop-up menu, select Delete. There is no warning before the entry is deleted. However, you can retrieve it from the Deleted Items folder.

DELETING A SINGLE CALENDAR ENTRY IN A RECURRING SERIES

Right-click on the entry you want to delete, and from the pop-up menu, select Delete. This message window will appear. Click on the button for Delete this one. The single entry will be deleted from the calendar, but all other entries in that recurring series will remain on the calendar. Of course, if you want to delete the entire series, click on the Delete all occurrences button.
COPYING A CALENDAR ENTRY
Position the mouse pointer over the left border of the calendar entry. The mouse pointer will change to a four-arrow symbol. Hold down the CTRL key and drag the entry to another location on the calendar, or on a date on the Date Navigator. You will see a plus sign appear beside the mouse pointer as you drag the item. Release the mouse button and the CTRL key. The entry will be copied to the new location. If you dropped it on a date on the Date Navigator, it will be at the same time slot as the original entry. If you dropped it on a time slot on the calendar, it will start at that time slot and continue for the duration set on the original entry.

MOVING A CALENDAR ENTRY
Position the mouse pointer over the left border of the calendar entry. The mouse pointer will change to a four-arrow symbol. Drag the entry to another location on the calendar, or on a date on the Date Navigator. Release the mouse button. The entry will be moved to the new location. If you dropped it on a date on the Date Navigator, it will be at the same time slot as the original entry. If you dropped it on a time slot on the calendar, it will start at that time slot and continue for the duration set on the original entry.

CHANGING A MEETING ENTRY
If you requested a meeting and then decide you need to change the time or date, right-click on the entry and click on Open. Make the change and click on the Save and Close button in the upper left corner of the window. You will be prompted to send the updated meeting information to the attendees. Click on the Yes button. Note that this is for changing meetings that YOU organized.

Microsoft Outlook
You have changed the meeting "Set up profiles in labs". Would you like to send this updated meeting to the attendees now?

Yes  No  Cancel
**VIEWING NON-CONSECUTIVE DAYS ON THE CALENDAR**

You may want to view several different non-consecutive days side-by-side. To do this, display the calendar in the One-Day view. Click on the first date that you want to display on the *date navigator*. Then, hold the CTRL key down and click on all other dates that you want to see side-by-side. The dates will display together.

This example shows several Fridays displayed side-by-side.

<table>
<thead>
<tr>
<th></th>
<th>Friday, Jul 13</th>
<th>Friday, Jul 20</th>
<th>Friday, Jul 27</th>
<th>Friday, Aug 03</th>
<th>Friday, Aug 10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>8 am</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>9 am</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>10 am</strong></td>
<td><strong>Search Committee</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>11 am</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>12 pm</strong></td>
<td></td>
<td></td>
<td><strong>Alumni Lunch</strong></td>
<td></td>
<td><strong>Farewell Party (AS 130)</strong></td>
</tr>
<tr>
<td><strong>1 pm</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2 pm</strong></td>
<td></td>
<td></td>
<td><strong>Planning Committee (AMC 154)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3 pm</strong></td>
<td><strong>request</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4 pm</strong></td>
<td><strong>test no response</strong></td>
<td><strong>test no</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To return to a normal display, click on a date on the *Date Navigator*. The calendar will display that single day.
Printing Calendar Entries

You may want to print parts of your calendar. There are many, many options for printing. You can use the dialog windows to see the many choices available to you.

With the calendar displayed, click on the File menu and select Print.

At this window, you can indicate the Print Style. The options are:
- Daily
- Weekly
- Monthly
- Tri-Fold
- Calendar Details

After selecting a style, indicate the Print Range—the start and end dates for the days you want to print. Note that you can hide the details of private appointments so the details don’t print.

You also have the options of Page Setup and Define Styles.
**Page Setup--Format**

This example shows the *Page Setup* for the *Weekly Style*. The *Format* tab is selected.

---

You can have the entries print top to bottom or left to right.

You can limit the entries to print on one page, allow them to print on two pages.

You can click on other tabs at the top of the dialog window for more options.
The *Paper* options allow you to print the calendar entries on a particular type of paper and in a particular size within the page. Under the *Size* options, you may scroll down to see even more selections—including *Franklin Day Planner, Day Runner*. 
PRINTING CALENDAR DETAILS

You may want to print your calendar entries and include all details rather than only the subject and location. Follow these steps to include all details.

Display the calendar.
From the File menu, click on Print and under the PrintStyle box, select Calendar Details Style. Under the Print Range, select the start and end dates for the range of days you want to print. Click on the Page Setup button and click on the Format tab. By default, the calendar entries will print continuously on as many pages as needed, or you can set the printing to begin a new page each Day, Week or Month.
Click on the Paper tab to select the paper and layout you want to use for printing. Use the Print Preview button at the bottom of the dialog window to see if the printing options you’ve set will print the entries the way you want them. If you don’t like the settings, click on the Page Setup button at the top of the Print Preview dialog window to change the settings. Continue to preview and change settings until you like what you see. Then click on the Print button. Select the printer and click on the OK button.
PRINTING MONTHLY CALENDARS

Outlook does its best to fit all of the information that it can onto a single printout. This is difficult to do when requesting a monthly printout of your Calendar. Outlook will not stretch its dividing lines and will instead truncate the titles of the appointments when things get too crowded. In that case, it will just show 4 items (possibly truncated) and then say “More items…” at the bottom. You’d have to resort to a Weekly view to get these printed out.

There are two ways a monthly calendar can print: that particular month only or the nearest 5 weeks to the day you were looking at.

The option described below uses the “nearest 5 weeks” method and allows printing 6 items per day instead of just 4. Ironically, this will print on a single page whereas the default option of one month per page may carry over into two pages.

Display the calendar. Go to the File menu, select Page Setup, then Monthly Style

Uncheck the bottom left box for Print Exactly One Month Per Page to get the “nearest 5 weeks” type of printout (which displays more items and is also most likely to print out as a single sheet).
Sharing a Calendar with Another User

Outlook/Exchange allows you to share a calendar with another user on the same server. You must be using the Outlook client as well as the Exchange server to make use of this feature. Both users must have accounts on the Exchange server.

PERMISSION LEVELS

You must give permission to another user to see and/or enter items on your calendar. You decide what level of access to give the user. These are the permission levels:

<table>
<thead>
<tr>
<th>LEVEL:</th>
<th>Functions available with this level:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Create, read, modify, and delete all items and files and create subfolders. As the folder owner, you can change the permission levels others have for the folder.</td>
</tr>
<tr>
<td>Publishing Editor</td>
<td>Create, read, modify, and delete all items and files, and create subfolders.</td>
</tr>
<tr>
<td>Editor</td>
<td>Create, read, modify, and delete all items and files.</td>
</tr>
<tr>
<td>Publishing Author</td>
<td>Create and read items and files, create subfolders, and modify and delete items and files you create.</td>
</tr>
<tr>
<td>Author</td>
<td>Create and read items and files, and modify and delete items and files you create.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Read items and files only.</td>
</tr>
<tr>
<td>Contributor</td>
<td>Create items and files only. The contents of the folder do not appear.</td>
</tr>
<tr>
<td>Custom</td>
<td>Perform activities defined by the folder owner.</td>
</tr>
<tr>
<td>None</td>
<td>Not open the folder; you have no permission.</td>
</tr>
</tbody>
</table>

Decide which level of permission is appropriate. Follow the steps to grant another user permission to access your calendar.
STEPS TO GRANT PERMISSION TO ANOTHER USER TO ACCESS YOUR CALENDAR

1. Open Outlook. Display the Folder List if it is not already displayed. (View menu, Folder List).
2. Right-click on the “Mailbox” icon in the Folder List and select Properties.
3. Click on the Permissions tab.
4. Click on the Add button and select the user to whom you are granting permission. Click on the “OK” button.
5. Place a checkmark in the “Folder Visible” checkbox and click on the “OK” button.
6. Right-click on the “Calendar” icon on the Outlook Bar.
7. Click on Properties.
8. Click on the Permissions tab.
9. Click on the Add button and select the user to whom you are granting permission. Click on the OK button.
10. Select the role you want the other user to have. Click on the OK button.

STEPS TO ACCESS ANOTHER USER’S CALENDAR AFTER YOU’VE BEEN GRANTED PERMISSION

1. Go to Tools menu and select Services. Make sure the Microsoft Outlook Exchange Server is selected.
2. Click on the Properties button and click on the Advanced tab.
3. Click on the Add button and type in the other person’s User ID or full name. Click on the OK button and at the next dialog window, click on the OK button.
4. The Mailbox icon for the other person will appear in your folder list. Click on the + symbol to expand the mailbox so you can see its calendar icon. (If necessary, click on the View menu and select Folder List to display the folder list.)
5. Drag the calendar icon to your Outlook Bar. This will give you a convenient shortcut to the other person’s calendar. You may want to right-click on this calendar icon and rename it so you can easily distinguish it from your own calendar icon.
6. If you want to keep the other person’s calendar open and easily accessible, open the calendar and then right-click in it. From the pop-up menu, click on Open in New Window. This allows you to have more than one Outlook window open at the same time. You can minimize this calendar window so it appears on your taskbar when you aren’t viewing it.
REMOVING PERMISSION TO A CALENDAR

If you have set up permission for another user to view and/or edit your calendar, and you no longer want that person to have those permissions, you may follow these steps to remove permission.

Right-click on the Calendar icon on the Outlook Bar. Click on Properties. Click on the Permissions tab. At the dialog window, click on the person’s name and click on the Remove button. Then click on the OK button.

If you had also granted permission for the user to view your Mailbox folder, right-click on the Outlook Today icon on the Outlook Bar. Click on Properties and then click on the Permissions tab. Select the person’s name and click on the Remove button and then click on the OK button.
Delegate Permissions

You may want to give another user the right to perform some actions on your behalf. These are delegate privileges. They may be set so that:

- Your delegate can invite others to meetings on your behalf
- Your delegate receives the responses to the meeting invitation
- Your delegate receives a copy of the meetings to which YOU are invited
- Your delegate responds to the meeting invitations on your behalf
- Your delegate may send e-mail messages that appear to come from him/her, but the messages will indicate that they were sent on your behalf

GRANTING DELEGATE PRIVILEGES

From the Tools menu, select Options. Click on the Delegates tab. Click on the Add button and select the person to whom you want to grant delegate privileges. Click on the OK button. Select the level of permission you wish to grant for each component and then click on the OK button.

It’s a good idea to send a message to your delegate to summarize the permissions you’ve granted.

You can decide whether the delegate may view any of your items that are marked “Private.”
SEND MEETING REQUESTS AND RESPONSES ONLY TO DELEGATES

Back at this dialog window you may place a checkmark at the bottom so that meeting requests and responses are sent ONLY to your delegates and not to you.

Sending E-mail Message on Behalf of Another

Open a new message window. From the View menu, select From Field if it doesn’t already appear in the message window. In the From field put in the person’s name. Then type the rest of the message and send it. The recipient will see this in the From line of the message:

From: Karen L. Wenz on behalf of zzKaren Trainer

The message was send by Karen Wenz, on behalf of zzKaren Trainer.
REQUESTING MEETINGS ON ANOTHER'S BEHALF

1. Open the other person's Calendar.
2. On the File menu, point to New, and then click Meeting Request.
3. In the To box, type the attendee names or click To to select from a list.
4. In the Subject box, type a description.
5. In the Location box, type the location of the meeting.
6. Type the start and end times.
7. Select other options you want.
8. Click Send

If you are set up as delegate for this person, and this person has indicated that delegates should receive the meeting responses, those responses will come to you, rather than to the person for whom you are delegate.

ZzKaren Trainer has allowed Karen Wenz to have delegate privileges, including receiving meeting responses on behalf of ZzKaren Trainer.

This is the type of response Karen Wenz would receive, as a delegate for ZzKaren Trainer.

<table>
<thead>
<tr>
<th>Accepted: Testing delegate privileges - Meeting Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Edit View Insert Format Tools Actions Help</td>
</tr>
<tr>
<td>Reply</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>☑ Mike Schomer has accepted.</td>
</tr>
<tr>
<td>Received on behalf of ZzKaren Trainer.</td>
</tr>
<tr>
<td>From:        Mike Schomer</td>
</tr>
<tr>
<td>To:          Karen L. Wenz</td>
</tr>
</tbody>
</table>
OPENING THE CALENDAR IN A NEW WINDOW

If you are viewing another person’s calendar, you may want to be able to keep it open at all times and keep it as a separate icon on the Windows Taskbar.

Right-click on the icon for the other person’s calendar and select *Open in New Window*. This will be a separate window from the Outlook application. You can minimize the calendar window and keep it available via the Windows Taskbar.

The calendar will appear as a separate icon on the Windows Taskbar.
Tasks are basically lists of things you need to do. You can describe the task and set a deadline for completing the task. To create a new task, click on the drop-down button by the New button and select Task. (There are other ways to create a task. This method allows for the most detail from you.)

At the dialog window, type in the details of the task:

Notice that you can set a start date, a due date and that you will be reminded at 8:00 a.m. on the due date. If you want to be reminded earlier than that, change the reminder date and time.

Notice that there is a Recurrence button here. You could schedule recurring tasks, such as monthly reports, semi-annual inventories, etc. and receive reminders about the tasks.

You can also use the Tasks as a daily “To Do” list that reminds you of phone calls you need to make, or letters you need to write, or documents you need to mail, such as conference registrations that are due by specific dates.
VIEWING TASKS

The default view for displaying your tasks is the Simple List:

Other available views are listed under the View menu, under Current View. To change the way you view your tasks, simply check the view you want.
**Tasks in the Outlook Today View:**

Overdue tasks appear in **red** typeface.

Uncompleted tasks that are not yet overdue appear in **black** typeface.

Completed tasks are displayed in **gray** typeface with **overstrike** and are **checked** as completed.
CUSTOMIZING TASK DISPLAY IN OUTLOOK TODAY

To change the way tasks are displayed on the Outlook Today screen, click on the Outlook Today button on the Outlook Bar. Then click on the Customize Outlook Today button in the upper right corner of the screen. In the Tasks area, click the options you want. Click on Save Changes.
Tasks in Calendar Display

Your tasks will also appear on your Calendar display:

Tasks will stay in your task list until you delete them. Completed tasks are not automatically deleted.
TASKS VS. CALENDAR ENTRIES

Tasks and Calendar Entries are actually somewhat similar, but there are differences that you should consider when determining whether it’s more appropriate to place an item on the calendar or on the task list.

**TASKS**
- You can use your Tasks component to make lists of tasks you need to complete.
- This allows you to see the list daily and to help keep you on track.
- Tasks serve as reminders of things you need to accomplish.
- The task list appears in a concise format.
- Tasks allow you to set deadlines for completion, and allow you to set reminders about the individual tasks.

However, tasks do not allow you to designate specific time blocks to complete the tasks.

**CALENDAR ENTRIES**
- You can use your calendar to schedule time to complete projects.
- This helps you to manage your time to ensure that you complete projects within designated time frames.

However, calendar entries do not allow you to see your projects and tasks in a concise format.

Based on this information, you can decide how to enter your tasks and projects. You may decide to enter things on both the task list and the calendar.
PUBLIC FOLDERS

The Exchange server at SCSU has some public folders that you may access. One feature in the Public Folders is a copy of the messages that are sent to the SCSU-Announce and SCSU-Discuss lists.

SCSU-ANNOUNCE & -DISCUSS

Display your Folder List and click on the + sign by Public Folders. Find the All Public Folders and expand it until you see SCSU Announce and SCSU Discuss. The messages that are posted to those two listservs are copied here for your convenience. You may read them at your leisure. The messages are kept there until they are more than 60 days old—then the messages are removed. You may want to use this feature rather than subscribe to the listservs. This way, the messages will not go to your Inbox, you will need to remember to check them from the Public Folders directory yourself.

You may respond to messages that are kept in these public folders. When you open a message, you will see this window and toolbar. Note that although there is a button to Post Reply, the reply will NOT be posted back to the listserv, but rather just back to this folder. However, if you click the Reply button, you will be able to reply privately to the original sender.
OWA (Outlook Web Access)

When you use Outlook with an Exchange server, you may check your e-mail from any web browser, without the use of any special software. Internet Explorer (I.E.) is the recommended browser. At this point, the web address is: https://mail.stcloudstate.edu/exchange

Notice that there is no www in the address, and it is https rather than http.

You may see some security screens pop up. Just click on “Yes” or “OK” to move forward.

After typing this in, you will be prompted for your user name, domain and password.

For the domain, you will use: stcloudstate with no spaces and no periods

The interface on the web browser differs from the desktop client interface you will be using on your work computer. The differences between the desktop client and the web interface are detailed on a Helpdesk web site http://www.stcloudstate.edu/help/faqs/outlookfeatures.html

You may use this interface when you are away from the office. You may read and send messages, create calendar entries and do many, but not all of the things you can do from the desktop client.

The web interface looks like this:

![The Outlook interface is through the Outlook toolbar only. The toolbar at the top relates to the web browser itself, rather than to Outlook.](image)

Right now, there is no way to log out of a browser session, so make sure you CLOSE the browser after you’ve finished reading your mail.
MANEUVERING IN THE OWA INTERFACE

In the OWA interface, you may view up to 25 messages per page. If you have more than 25 messages in your Inbox, you will see a Page navigator. It will display the current page number and forward and backward arrows to move to the next or previous page of messages. You may also just type in a number to display that page of messages.

Use the icons on the left to display the Inbox, Calendar, Contacts and Options.
USING THE OUTLOOK TOOLBAR IN OWA

This toolbar is displayed when your **Inbox** is selected. Position your mouse over a button to see a sticky note that describes its function. From left to right:

*Create* anew mail message,
*Reply* to the selected message,
*Reply to all recipients* of the selected message,
*Forward* the selected message,
*Check* for new messages,
*Move* the selected message to a folder,
*Delete* the selected message,
*Empty* the Deleted Items folder,
*Display the Preview Pane* (or remove it from display),
*Search* the Global Address List,
*Change* the *View* of the Inbox (Unread Messages, All Messages, By Sender, By Subject, etc.)
*Get Help*
SENDING A MESSAGE IN OWA

Click on the New Message button and this window will appear:
Click on the To button to find a person’s name (or type in the entire address if you know it).

Type in a last or first name and click on the Find button. (you may also type in part of a name)
You will see a list of matches displayed. Select the name and click on the appropriate button at the bottom of the window: To, Cc, Bcc. Then click on the Close button, or search for another name.

Note that the person’s name appears ABOVE the To field, rather than IN it.

Continue to type your message and then click on the Send button in the upper left corner of the window.
USING “CHECK NAMES” TO SEND A MESSAGE

You may also send a message by typing part of the person’s name in the To field and then clicking on the Check Names button on the Message Window.

If more than one matching name is found, you will get a list to select from. Select the person you want to send the message to and click on the OK button. Continue with the message.
SETTING OPTIONS WHEN SENDING A MESSAGE

Click on the *Options* button on the message window to set any special options (Read Receipt, etc.) Select the options you want for that message and click on the “X” to close the Options window.
INSERTING A FILE ATTACHMENT

From the Message Window, click on the *paper clip* icon and you will see this dialog window. Click on the *Browse* button to find the file.

Navigate to the file location and select the filename. Click on the *Open* button.

Click on the *Attach* button at the next dialog window.
The file will be listed under **Current file attachments**. You may add more than one attachment to a message. When finished adding attachments, click on **Close**.

(You could remove the file attachment at this point if you changed your mind—click in the checkbox and click on the **Remove** button.)

You will return to the Message Window where you can complete the message and click on the **Send** button in the upper left corner of the window.
Password Change

There are many different scenarios for users across campus—some people use Windows 95, some use 98, some use NT and some use 2000. Some users log into the stcloudstate domain, some do not. Some use the MnSCU applications, some do not.

The password change procedures do vary slightly depending on your particular scenario, so it is best to discuss your particular situation with your Tech Support person, or with someone at the Helpdesk.

To find the most efficient method for changing your password, you need to determine:

- Whether you log into the STCLOUDSTATE domain**
- Which Operating System you use (Windows 95, 98, NT, 2000, or other ***….)
- Whether you use the MnSCU modules (this means you have a username and password on the STC2 server that allows you access to MnSCU modules or databases—PCS, Payroll, Student Records).
- Whether you use a Mac and/or a Windows PC
- Whether you log into a department server (you may ask your Tech Support person about this)

Talk to your Tech Support person to determine the best method for password changes, and to obtain detailed instructions for the password change procedure.

** If you are logging into the stcloudstate domain when you boot your computer, you will see a screen that looks like this. Note the field for “Domain” and the STCLOUDSTATE that indicates you are logging into the STCLOUDSTATE domain.

*** To determine your Windows operating system, right-click on the Start button and click on Explore. In the Windows Explorer window, click on the Help menu and select About Windows… to see which version is installed on your computer.
PASSWORD CHANGE VIA OWA (OUTLOOK WEB ACCESS)

Talk to your Tech Support person to determine whether you should use this method to change your password.

CAUTION: At this time, do not use the “Change Password” button you see at the sign-on screen for Outlook (unless you are running WINDOWS 2000).

To change the password via the web, go to this web site:  https://mail.stcloudstate.edu/exchange/
Note that there is an “s” after the “http” in this address. Depending on which web browser you use, you may see some security alert screens. Click on whatever you need to in order to proceed (“Yes” or “OK”). These are the screens that display in I.E. 5.0 when used from on campus:

Internet Explorer 5.0 on campus

![Security Alert](image)

You are about to view pages over a secure connection.

Any information you exchange with this site cannot be viewed by anyone else on the Web.

In the future, do not show this warning

[OK] [More Info]

![Security Alert](image)

Information you exchange with this site cannot be viewed or changed by others. However, there is a problem with the site’s security certificate.

The security certificate was issued by a company you have not chosen to trust. View the certificate to determine whether you want to trust the certifying authority.

The security certificate date is valid.

The security certificate matches the name of the page you are trying to view.

Do you want to proceed?

[Yes] [No] [View Certificate]
On campus, you will see this prompt. From off campus, you will also be asked to type in the domain, which is `stcloudstate`.

Click on the **Options** icon on the Outlook Bar.

Scroll down to the **Password** category. Click on the **Change Password** button.
Type in the domain, your user ID, old and new passwords and click on the OK button. Note that the domain is stcloudstate with no spaces, no periods.

You should see a confirmation that your password was successfully changed. If you are in the Active Directory, this password change will also change the password you use to log on to your computer at boot up. Any questions, call your tech support or the Helpdesk at 255-2077.

When you change the password via the web browser, you may still need to change the Windows password that is stored on your local hard drive. Ask your Tech Support person about this.